
L'information sismologique en ligne :
logiciels et ressources internet

d'intérêt pédagogique
Cyril Langlois

Abstract

Cet article décrit et commente l'utilisation de plusieurs ressources informatiques permettant
d'aborder la sismicité mondiale et la sismologie et utilisables par les enseignants. Ces
ressources consistent soit en sites internet proposant des outils de recherche et de traitement
des données sismiques à distance via un navigateur internet, soit en interfaces logicielles
(multi-plateformes et gratuites) permettant d'interroger à distance les catalogues de sismicité et
les réseaux sismiques mondiaux puis de traiter localement ou à distance les sismogrammes
choisis.

Introduction
Même si le principe de base du sismographe reste celui du ressort pesant représenté dans tous les ouvrages
d'enseignement et de vulgarisation, les stations de mesures sismiques (ou « stations sismologiques ») actuelles
n'ont plus grand-chose de commun avec ces instruments anciens. Elles enregistrent désormais la sismicité sous
forme numérique, transmettent leurs données via le réseau internet et sont entretenues à distance de la même
façon. Chaque station sismique est aussi, désormais, un élément d'un vaste réseau et les données sismiques sont
rassemblées, traitées et redistribuées à la communauté des sismologues par des consortiums et des organismes
nationaux et internationaux.

Les sismologues récupérent donc aujourd'hui leurs données par des requêtes envoyées à ces bases de données
par le réseau internet. Mais ces sites de ressources sismologiques sont également accessibles à tout un chacun et
plusieurs d'entre eux fournissent également des informations scientifiques vulgarisées ou des outils
pédagogiques à destination des élèves et des enseignants. Certains intervenants de la communauté sismologique
(chercheurs, universitaires et enseignants) ont aussi développé et mis à la disposition du public des interfaces
logicielles qui permettent, sans aucune connaissance en informatique ou en programmation, de consulter facile-
ment les catalogues de sismicité disponibles sur les serveurs des différents réseaux sismologiques, de visualiser
les sismogrammes enregistrés par les stations et de les exploiter soi-même.

Cet article se propose de présenter quelques-uns de ces outils scientifiques d'utilité pédagogique, sans viser à
l'exhaustivité. Si beaucoup de ces ressources nécessitent quelques rudiments d'anglo-saxon, certaines ont
l'avantage d'être disponibles en français. Tous, par contre, imposent de disposer d'une connection à l'internet au
débit suffisamment élevé pour assurer un fonctionnement et une utilisation agréables. Enfin, en ce qui concerne
les logiciels, ne sont présentés que des applications gratuites et utilisables sur différents systèmes d'exploitation.

Les sites de suivi de la sismicité régionale et mondiale
La majorité des sites internet consacré à l'information sismologique affichent une carte dynamique sur laquelle
sont reportés les événements sismiques récents. Placer sa souris ou cliquer sur les symboles cartographiés per-
met d'accéder aux informations relatives à chaque séisme. Dans une certaine mesure, ces sites sont donc « re-
dondants » (et souvent reliés les uns aux autres), mais se distinguent dans les détails de leur contenu ou dans
leurs objectifs.

Généralement, ces sites ne proposent à l'échelle mondiale que les séismes de magnitude supérieure ou égale à 4
(sismicité légère), mais fournissent une couverture plus complète de la région à laquelle ils sont plus
particulièrement consacrés.

Sites français
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SisFrance (BRGM), la sismicité de France métropolitaine et d'outre-mer

http://www.sisfrance.net/sommaire.asp?ACCUEIL=0

Le site SisFrance fournit un accès via une carte cliquable et un moteur de recherche aux séismes survenus en
France métropolitaine et en outre-mer. L'objectif principal du site semble donc d'abord de fournir une base de
données historique. Cela explique aussi que la légende de la carte privilégie l'échelle d'intensité à celle de mag-
nitude.

Figure 1. Page d'accueil du site SisFrance

La page d'accueil du site permet de rechercher la sismicité enregistrée :

• au niveau d'une région, en fournissant au formulaire d'interrogation de la base de données les coordonnées
géographiques de la zone souhaitée ;

• dans un département,

• dans une commune, en donnant son nom dans le formulaire et en cliquant sur « rechercher ». Une fois la
commune trouvée, les séismes peuvent être cartographiés.

La carte qui s'affiche alors montre la localisation des séismes avec un code de couleur et de taille des symboles
correspondant à l'intensité sismique de l'événement (ci-dessous, un exemple de recherche au niveau d'une com-
mune, avec la ville de Grenoble). Les boutons au dessus de la carte permettent, en les sélectionnant puis en cli-
quant sur la carte, de revenir à la carte régionale des séismes, de zoomer, dézoomer sur le point choisi, et
d'afficher les informations relative au tremblement de terre sélectionné.

Figure 2. Recherche de sismicité sur une commune : Grenoble
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Le site du Bureau Central Sismologique Français

http://www.franceseisme.fr/

Le site du BCSF a pour vocation de « coordonner, diffuser, archiver les observations sismologiques », d'abord à
l'échelle de la France. Il fournit donc sur sa page d'accueil :

• les cartes de sismicité de France mais aussi d'Europe (par partage des données de l'EMSC, voir section suiv-
ante) ;

• les dernières alertes sismiques enregistrées en France (métropolitaine et d'outre-mer) ;

• des informations relatives aux enquêtes réalisées autour d'événements sismiques français : il donne ainsi
accès aux formulaires par lesquels les personnes présentes sur les lieux du séisme peuvent enregistrer leur
témoignage, utilisé ensuite pour établir les cartes d'intensité sismique.

Figure 3. Page d'accueil du site internet du BCSF (à la date du 26 mars 2007)
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Le site du BCSF permet encore d'accéder aux bases de données des observatoires et des réseaux sismologiques
de France (IPGP, BRGM), dont celles de SisFrance présentée plus haut. En accord avec son objectif affiché de «
coordonner » et de « diffuser » l'information sismologique, ce site est donc un portail qui peut servir de point
d'accès à d'autres sites présentés ici, mais aussi à d'autres ressources.

On y trouve par exemple (dans le menu de gauche « documents ») un lien vers les documents pédagogiques re-
latifs à la sismicité mis à disposition par l'Ecole et l'Observatoire des Sciences de la Terre de Strasbourg
(EOST), ainsi que vers une collection de petites vidéos (« documents > vidéos pédagogiques ») dans lesquelles
des sismologues professionnels expliquent brièvement divers sujets relatifs à la sismicité et à la prévention des
risques (sismicité française, effet de site, etc.).

Le BCSF a encore comme particularité d'accorder une large place à son rôle d'enquêteur et de cartographe de
l'intensité sismique. Une page du site explicite ainsi les objectifs de ces enquêtes de sismicité tandis qu'une autre
explicite, illustrations à l'appui, les différents niveaux d'intensité sismiques définis sur l'échelle standard
européenne EMS98. Cette source d'information est donc particulièrement utile pour faire comprendre la distinc-
tion entre magnitude et intensité sismique et bien montrer que ces deux paramètres se distinguent non seulement
par leur définition et l'information qu'ils contiennent mais également par la façon dont ils sont obtenus (mesures
instrumentales d'un côté, enquêtes et recueil de témoignages de l'autre).

Le site de L'EMSC, la sismicité euro-méditerranéenne
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http://www.emsc-csem.org/index.php?page=home

Le Centre Sismologique Euro-Méditerranéen propose sur son site internet un ensemble d'informations sis-
mologiques essentiellement concentré sur la région méditerranéenne. La page d'accueil présente ainsi une carte
de la sismicité (M # 3) récemment enregistrée autour de la Méditerranée où les séismes sont reportés avec un
code de couleur fonction de la date de l'évènement. Là aussi, il est possible de basculer sur une carte de la
sismicité mondiale (M # 4).

Ce site fournit également (dans le menu déroulant de gauche), par une application Java, la possibilité d'afficher
sélectivement les séismes d'une période de temps choisie (à l'aide des boutons de gauche) pour une région
particulière (monde entier, Méditerranée, Amérique du Nord ou du Sud, Afrique et Océan Indien, Asie). Les
séismes sont cette fois colorés selon la profondeur de l'épicentre.

Le bouton « see animation », à gauche, permet d'afficher séquentiellement les séismes survenus pour la période
de temps choisie, une fonction qui permet de s'interroger sur les possibles relations entre séismes d'une zone
géographique relativement restreinte (modifications de l'état de contrainte tectonique sur une faille ou sur une
région sismique à la suite d'un séisme, répliques et séismes « précurseurs »).

Figure 4. Exemple d'utilisation de la carte interactive de sismicité de l'EMSC. On a
sélectionné ici la carte de la région euro-méditerranéenne et choisit d'afficher la
sismicité enregistrée entre le 26 février et le 26 mars 2007 à l'aide des boutons du menu
de gauche. Le bouton "see animation" permet de faire défiler les cartes de sismicité
journalières sur cet intervalle de temps.

Cliquer sur l'un des séismes permet d'accéder à une nouvelle page d'informations, comportant plusieurs onglets :

• le premier (« Summary ») propose les informations de base relative à la secousse sismique sélectionnée
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(localisation, magnitude) ;

• le suivant (« Maps ») propose différentes vues cartographiques de l'épicentre (vue globale, régionale, locale
ou sur une carte Google Map) ;

• alors que le troisième (« Regional seismicity ») fournit une carte de la sismicité historique de la région et la
liste des principaux grands séismes survenus dans la zone depuis 1500.

Ce site, d'abord destiné aux sismologues professionnels, fournit encore la liste et les caractéristiques des princi-
paux séismes méditerranéens récents, leur analyse (tenseur des moments, etc.), un bulletin d'information sis-
mologique trimestriel et d'autres informations relatives à l'EMSC.

Le site de l'USGS Earthquake Hazard Program

http://earthquake.usgs.gov/

Equivalent pour les Etats-Unis du BCSF ou de l'EMSC, ce portail d'information affiche lui aussi sur sa page
d'accueil des cartes de sismicité, mondiale (M # 4) et centrée sur les Etats-Unis (M # 1).

Figure 5. Page d'accueil de la section du site de l'U. S. Geological Survey dédié à la
surveillance sismique.

Une fois encore, une pression de la souris sur une région permet de zoomer en affichant des cartes d'échelle
croissante. Les séismes y sont cette fois représentés avec un code de couleur fonction de leur ancienneté (une
heure plus tôt, un jour plus tôt, la semaine passée). La sélection d'un événement sismique permet d'obtenir une
page d'informations sur ce tremblement de terre. Cette page s'organise de manière très similaire à celle de
l'EMSC, avec plusieurs onglets :
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• « Détails » : les paramètres géographiques de l'événement, sa magnitude, sa profondeur#

• « Summary » : des liens vers une collection d'informations sur la sismicité de la région et du pays concerné

• « Maps » : plusieurs représentations cartographiques de l'épicentre (vue globale, régionale, etc.)

• l'onglet « Scientific & Technical » donne accès au tenseur des moments sismique (autrement dit le
mécanisme au foyer, représenté par la sphère focale) du séisme, établi par l'USGS, mais aussi à une carte des
temps d'arrivée théoriques des ondes sismiques P (calculés à partir du modèle de Terre IASP91, analogue
plus récent du modèle PREM).

De la même manière que sur le site de l'EMSC, là aussi, il est possible de visualiser sur une carte la séquence
des séismes enregistrés sur les derniers jours : une fois sélectionnée, sur la page d'accueil, la carte de sismicité
voulue (sismicité globale ou sismicité des seuls Etats-Unis), la nouvelle page obtenue (Latest Earthquakes) pro-
pose dans son menu de gauche une case « Animations ».

Le même menu conduit également à d'autres pages rassemblant les séismes historiques, ou donnant accès à un
moteur de recherche de sismicité ou encore à des logiciels plutôt destinés aux sismologues professionnels ou
aux étudiants et enseignants d'université.

Comme la plupart des sites des grandes agences américaines (NOAA, USGS, NASA), ce portail rassemble une
quantité de pages et d'informations impressionnantes, s'adressant à des publics variés allant du spécialiste à
l'élève de collège, qu'il est impossible de décrire ici.

À côté et en complément de ces ressources qui ne demandent de disposer que d'un navigateur internet récent et
munis des extensions (« plug-in ») adéquates (technologie Java, lecteur de vidéo, etc...), on peut trouver d'autres
outils passant cette fois par des interfaces logicielles spécifiques et qui, pour certaines, permettent d'aller beau-
coup plus loin que la simple visualisation de la sismicité.

Les interface logicielles dédiées

La solution « intermédiaire » Google Earth

Le succès du logiciel Google Earth est mis à profit par le programme de surveillance sismique de l'USGS qui
propose le téléchargement d'un fichier spécifique (.kmz) permettant d'afficher directement dans Google Earth la
sismicité mondiale des sept derniers jours. Les séismes sont représentés par des symboles de taille proportion-
nelle à la magnitude et de couleur fonction de la date du séisme (dernière heure, dernier jour, semaine passée),
exactement comme sur le site de l'USGS. Le fichier fournit également au passage l'affichage des limites des
plaques tectoniques et des failles transformantes (chaque affichage pouvant être coché ou décoché dans le menu
de gauche du logiciel).

Figure 6. Sismicité des derniers jours et limites de plaques affichés dans Google Earth :
exemple du 26 mars 2007. Les séismes survenus le 25 et 26 mars à l'Ouest du Japon, par
exemple, sont affichés en orange et jaune.
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Note

Google Earth propose également, d'origine, une localisation « basique » des séismes (parmi les «
caractéristiques géographiques » disponibles dans les « infos pratiques »), obtenu par consultation des
catalogues de sismicité du NEIC (National Earthquake Information Center, Etats-Unis).

Cette solution a donc pour principal l'intérêt l'affichage cartographique sur un globe plutôt que sur une projec-
tion cartographique 2D et la facilité de déplacement d'un point à l'autre. Cliquer sur le symbole d'un séisme per-
met d'ouvrir une fenêtre dans laquelle s'affiche les coordonnées géographiques du séisme et les liens vers d'autre
informations proposées par l'USGS. Il est ainsi possible d'importer directement dans Google Earth la carte
d'intensité (ShakeMap) établie par l'USGS. Cependant, un examen plus approfondi des caractéristiques d'un
séisme impliquent de revenir à la consultation du site de l'USGS par un navigateur internet, à l'aide des liens
proposés.

Figure 7. Importation directe dans Google Earth de la carte des intensités (ShakeMap)
proposée par l'USGS. Exemple du séisme du 25 mars 2007, à l'ouest du Japon (M 6,7).
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Le site de l'EMSC propose quant à lui sur sa page d'accueil les fichiers .kmz permettant l'affichage dans Google
Earth de la sismicité mondiale :

• des deux dernières semaines ;

• ou de l'année écoulée.

Par ailleurs et, à nouveau, comme sur la carte interactive du site internet de l'EMSC, la couleur des symboles lo-
calisant les séismes est reliée cette fois à la profondeur de l'hypocentre (une information qui n'est fournit par
l'USGS qu'après sélection d'un séisme individuel et non pas cartographiquement). Comme dans le cas précédent,
la sélection d'un séisme permet d'afficher ses principales caractéristiques géographiques.

Figure 8. Affichage dans Google Earth de la sismicité enregistrée par l'EMSC. Les
données relatives à un séisme survenu le 25 mars 2007 sont affichées.
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Cette fonctionnalité dans Google Earth se limite donc aux informations cartographiques et ne donne pas accès
directement à l'étude des sismogrammes des tremblements de terre. D'autres logiciels vont beaucoup plus loin,
en fournissant une interface de cartographie et d'analyse poussée des séismes et de leurs enregistrements.

The Global Earthquake Explorer (GEE)

http://www.seis.sc.edu/gee/

GEE est un logiciel d'analyse sismologique spécifiquement conçu pour les enseignants et leurs élèves par le
Département de Sciences Géologiques de l'université de Caroline du Sud et le consortium sismologique IRIS.
Dans sa version actuelle (2.1.4), il fonctionne sur les trois principales plate-formes informatiques grand public.

L'information sismologique en ligne
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Une fois installé sur l'ordinateur, ce programme propose au lancement un menu donnant accès à plusieurs
moyen d'exploration et d'analyse de la sismicité.

Figure 9. Menu d'ouverture du logiciel GEE

Les quatre premières propositions permettent une exploration « libre » de la sismicité mondiale. Les trois suiv-
antes sont des modules d'enseignement préétablis à partir de sismogrammes et d'informations sélectionnés.
Même si ces séquences sont évidemment élaborées en fonction des programmes et des méthodes pédagogiques
américains, elle sont facilement transposables et réutilisables dans le cadre des enseignements français. Seule la
première d'entre elle, qui permettra aussi de décrire le mode d'utilisation du logiciel, sera décrite ici.

Les modules d'enseignement

La sélection de la ligne « Intro to GEE Module » est une bonne porte d'entrée pour découvrir l'utilisation de ce
logiciel avec une classe (niveau 3e). L'objectif de ce module est d'introduire les notions générale d'onde et de
train d'ondes sismiques, puis d'expliquer le principe de la localisation des séismes à l'aide de la différence de
temps d'arrivée des ondes P et S. Le lien de la page de démarrage conduit à une nouvelle fenêtre, reproduite ci-
dessous.

Figure 10. Page de démarrage du module "Introduction to GEE Module"
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À partir de cette fenêtre, le bouton inférieur (« export Student Materials#» ) permet de sauvegarder localement
sur son disque dur un dossier contenant plusieurs fichiers PDF destinés aux élèves. Ils ne sont disponibles qu'en
anglais, mais leur contenu fournit à l'enseignant une base pour créer ses propres supports de travail pour sa
classe. Il s'agit dans ce cas précis :

• d'un fichier de cours (IGEE-Background-v3.pdf), où sont expliqués les notions générales d'onde, de
longueur d'onde, de périodicité spatiale et temporelle d'une onde, etc.

• d'un fichier d'explication sur l'utilisation du logiciel GEE (IGEE-Instructions.pdf) ;

• d'un tableau dans lequel l'élève reporte les temps d'arrivée des ondes P et des ondes S repérées sur les sismo-
grammes fournis et les différences de temps d'arrivée (IGEE-DataTable.pdf) ;

• d'une carte topographique simple représentant la région sismique étudiée dans le module (le rift africain dans
la région des grands lacs) ;

• d'une carte muette de la même région portant la localisation des stations sismiques utilisées ;

• d'une série d'instruction et de questions auxquelles l'élève pourra répondre lors de cette séquence
pédagogique.

L'enseignant, quant à lui, dispose d'une autre collection de fichiers PDF, téléchargeable à partir de la barre de
menu principale du logiciel, en sélectionnant dans le menu déroulant « Help » la ligne « Save Teacher Materials
». L'un de ces fichiers (GEE-TeachersGuide.pdf) décrit la séquence pédagogique que peut suivre l'enseignant
(les questions à aborder, les réponses attendues, les connaissances à apporter, etc.), un autre rappelle brièvement
le principe de la localisation d'un tremblement de terre à partir des temps d'arrivée des ondes mesurés sur les sis-
mogrammes.

L'information sismologique en ligne
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Les deux autres onglets en haut de la fenêtre principale, « Seismogram display » et « Map », permettent
d'afficher respectivement les sismogrammes enregistrées par les stations sismiques et la carte topographique de
localisation.

L'affichage des sismogrammes permet de voir les enregistrements de six stations sismologiques. Pour cet exerci-
ce, les sismogrammes présentés sont des sismogrammes « bruts », tels qu'enregistrés numériquement par les sta-
tions, et par conséquent gradués verticalement en « counts » et non en unités internationales. On remarquera tout
de suite que l'amplitude des signaux obtenus diffère d'une station à l'autre. On n'utilise ici que les composantes
verticales de l'enregistrement sismique, enregistrées par pas de temps de 0,1 s (composante BHZ des sismo-
grammes).

Note

Ces sismogrammes sont des enregistrements de la vitesse du sol (les sismomètres actuels sont en
général des vélocimètres), non du mouvement du sol.

Le temps d'origine du séisme étant à priori inconnu, les sismogrammes ne sont pas alignés, mais commencent au
temps d'obtention des données pour chaque station. Plusieurs outils sont alignés au dessus des sismogrammes.
Ils permettent :

• de déplacer le pointeur sur un tracé : les coordonnées du pointeur sont simultanément repérés sur les axes du
sismogrammes par des curseurs à contour rouge, tandis que les valeurs des coordonnées (temps et amplitude
du signal sismique) en ce point s'affichent en bas à droite du tracé ;

• de zoomer, dézoomer et déplacer manuellement les tracés (les flèches et le carré proposés à droite de la barre
d'outils permettent de faire défiler les enregistrements) ;

• de sélectionner et d'afficher dans une nouvelle fenêtre une portion d'un tracé ;

• d'ajouter des « drapeaux » localisant les arrivées des différentes ondes ;

• d'exporter les tracés dans un fichier PDF ;

• de modifier l'affichage des tracés avec les menus « display », « add to display » et « remove to display ». Le
menu « display », par exemple, permet de superposer les tracés, de les afficher par ordre alphabétique ou en
fonction de leur distance à la source, ou encore d'y superposer des « filtres » représentant des sismogrammes
synthétiques de séismes locaux, régionaux ou lointains.

Figure 11. Fenêtre de visualisation des sismogrammes. Les temps d'arrivée des ondes P
et S ont été pointés manuellement sur l'un des enregistrements à l'aide du bouton
représentant un drapeau.
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Les élèves peuvent donc pointer sur ces sismogrammes, à l'aide de drapeaux, les temps d'arrivée des ondes P et
S puis, à l'aide des différences de temps, d'un compas et de la carte imprimable, de localiser la zone épicentrale
du séisme.

L'exploration sismique « manuelle »

Les autres options affichés sur la page de démarrage de l'application permettent une utilisation plus personnelle
du logiciel et de ses nombreuses possibilités. Pour revenir à cette page, il suffit de sélectionner dans la barre de
menu « File > Reset Global Earth Explorer ».

• La ligne « Explore a Regional Hot Spot » propose une exploration de la sismicité de plusieurs régions
prédéfinies, à la fois particulièrement actives et bénéficiant d'une bonne couverture de stations sis-
mologiques. Il s'agit du Mont Saint-Helens (sismicité lié à l'activité volcanique), de la Californie (avec
évidemment l'activité de la faille de San Andreas et des failles associées, surveillé par le réseau sismique le
plus dense du monde), de l'ensemble des USA ou, enfin, du Sud-Est asiatique.

• Le choix « Sismograph Day Viewer » fournit la carte de l'activité sismique du jour et des stations sis-
mologiques en état de fonctionnement. Sélectionner une ou plusieurs stations permet d'en afficher ensuite
l'enregistrement (cf. plus loin).

• D'une façon similaire, le choix « Real Time Viewer » permet d'afficher l'enregistrement en en temps réel
d'une station sismique choisie par l'utilisateur à partir d'une carte.

Toutes ces « portes d'entrée » du logiciel fonctionnant de façon très similaire, on ne décrira ici que le cas de la
consultation des séismes récents (ligne « Explore Recent Earthquakes »). Ce choix conduit lui aussi à l'affichage
d'une carte, sur laquelle sont placées :

L'information sismologique en ligne
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• les stations en état de fonctionnement, représentées par des triangles bleus (les triangles gris indiquent les
stations qui ne répondent pas) ;

• les séismes récents, localisés par des cercles dont la taille et la couleur correspondent respectivement à la
magnitude et à la profondeur du séisme (superficiel, moyen, profond) ;

• les lignes d'égal temps d'arrivée des ondes P par rapport à un séisme particulier.

Cliquer sur l'un des cercles permet de sélectionner le séisme correspondant (dont la date, les coordonnées
géographiques, la profondeur et la magnitude s'affichent au bas de la carte). Les lignes des temps d'arrivée sont
aussitôt réorganisées autour de cet événement.

De la même façon, l'utilisateur peut sélectionner à la souris une ou plusieurs stations (dont le contour devient
alors blanc ; un bouton de la barre d'outil permet de les « déselectionner » toutes). La distance épicentrale des
stations par rapport à l'événement considéré vient s'afficher en bas à droite de la carte (en degrés).

Figure 12. Carte de localisation des séismes récents. Le séisme considéré (côte ouest du
Japon, 25 mars 2007, 00h42 GMT, magnitude 7,3) est indiqué par un disque à fond
grisé. Plusieurs stations (triangles à contour blanc) sont sélectionnées. Les
caractéristiques de la dernière station choisie apparaissent en bas à droite de la fenêtre.

Un nouveau clic sur le bouton « Load Selected Stations » permet d'importer dans la fenêtre suivante « Seismo-
gram Display » la période d'acquisition des stations pendant laquelle le séisme choisi a pu être enregistré. Par
défaut, ces enregistrements sont d'abord affichés sur un même graphique temps-distance épicentrale, avec une
couleur différente pour chaque station. Encore une fois, seule les composantes verticales des sismogrammes
sont proposées (figure ci-après).
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L'utilisateur peut ensuite, s'il le souhaite, afficher séparément chaque tracé en les alignant verticalement par or-
dre alphabétique ou par distance épicentrale, par exemple, à l'aide du menu « Display ». Ce même menu « Dis-
play » permet aussi, cette fois-ci, d'importer et d'afficher automatiquement les pointés des temps d'arrivées des
ondes sismiques (voir la figure).

Figure 13. Graphique temps - distance épicentrale des enregistements des quatre
stations sélectionneés pour le séisme de l'Ouest du Japon du 25 mars 2007. Sur cette
image, les temps d'arrivées des ondes sismiques ont été automatiquement calculées et
ajoutées et les tracés ont été alignés sur le temps origine du séisme.

Lorsque les tracés sont affichés séparément (par la commande « Display > Show Individual Traces »), et si les
informations sur les caractéristiques des stations sont disponibles dans les données téléchargés par le logiciel, les
sismogrammes peuvent s'afficher en unités réelles (millimètre.s-1 ou micromètre.s-1) : il est alors possible de dis-
cuter, par exemple, de l'atténuation beaucoup plus rapide des ondes de volume que des ondes de surface avec la
distance épicentrale.

Le pointé des temps d'arrivée des ondes, s'il est fait automatiquement (à l'aide du menu « Display > Overlay
Travel Time ») comme présenté ci-dessus, est obtenu par le programme via un calcul des temps d'arrivée des
ondes à partir d'un modèle de terre sismologique. Par défaut, il s'agit du modèle IASP91. Un module de calcul
des temps de trajet, disponible dans le menu Outils (« Tools »), permet de choisir le modèle utilisé et même de
visualiser le trajet de ces ondes : il ouvre une nouvelle fenêtre dans lequel l'utilisateur peut spécifier manuelle-
ment :

• la distance épicentrale qu'il souhaite (en degrés)

• la profondeur du séisme (en km), s'il la connaît

L'information sismologique en ligne
: logiciels et ressources internet

16



• le modèle de Terre a utiliser, parmi trois possibilités : IASP91, PREM et QDT

Le module détermine alors les trains d'onde de volume susceptibles d'apparaître sur les sismogrammes pour ces
paramètres et leur temps d'arrivée. Un onglet, en haut de la fenêtre, permet ensuite d'afficher les trajets de ces
ondes de volume (figure ci-après).

Figure 14. Le module de calcul des temps de trajet des ondes de GEE : un exemple pour
une distance épicentrale de 120°, un hypocentre à 10 km de profondeur et le choix du
modèle IASP91. Le trajet en rouge correspond à l'onde sélectionnée à gauche (onde
Pdiff diffusée à la limite noyau-manteau).

Signalons encore que les sismogrammes analysés peuvent être sauvegardés localement sur l'ordinateur (dans le
format de données SAC) et réutilisés ensuite. De la même façon, il est possible de rechercher manuellement les
enregistrements d'un séisme précis, par exemple d'un séisme majeur récent, à l'aide de la commande « Edit >
Earthquakes > Noteworthy Earthquakes » disponible dans le menu « Edit », ou en allant consulter les banques
de données sismiques du consortium IRIS (« Edit > Earthquakes > All Earthquakes »). Dans le même menu, la
commande « Edit > Station Chooser » permet également de sélectionner une ou plusieurs stations et le type
d'enregistrement souhaité (uniquement les grandes ou les courtes longueurs d'onde, la composante verticale
seule ou les trois composantes (verticale, N-S et E-O), etc.).

Le logiciel GEE offre donc une large gamme d'outils d'analyse de la sismicité et des enregistrements sis-
mologiques.La possibilité de l'utiliser en suivant des modules d'enseignement prédéfinis ou pour des recherche
ciblées et personalisées en fait un outil utilisables à divers niveaux, du collège à l'université. On ne peut lui re-
procher que de n'être pas disponible en français.

Cependant, un dernier logiciel, d'avantage destiné aux sismologues professionnels mais disponible, lui, en
français, permet d'effectuer des travaux similaires à GEE.

Quake Explorer et SeisGram2K

http://alomax.free.fr/QuakeExplorer/beta/
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http://alomax.free.fr/seisgram/SeisGram2K.html

SeisGram2K est un logiciel d'analyse d'enregistrement sismique disponible en français, anglais ou italien, écrit
en langage Java. Son concepteur en propose deux versions, dont l'une (SeisGram2K52_ECOLE) est
spécifiquement destinée à une utilisation par des enseignants et des élèves, dans le cadre des programmes « Sis-
mo des écoles » développé par Géosciences Azur et l'Académie de Nice et du programme national « SISMOS à
l'Ecole » en cours de réalisation.

Comme GEE, SeisGram2K permet de visualiser des données sismiques téléchargés dans les bases de données
professionnelles ou parmi les sismogrammes enregistrées par les stations installées dans les établissements sco-
laire des réseaux pédagogiques et mis à disposition sur les sites internet de ces programmes.

Note

Dans ce dernier cas, les enregistrements peuvent aussi être directement visualisés en ligne sur internet,
l'application SeisGram fonctionnant alors à distance comme une « applet » Java.

Contrairement à GEE, donc, SeisGram2K ne fournit pas, en tant que logiciel individuel, d'outil intégré de
recherche de séismes et d'importation de données. Cependant, un autre logiciel du même auteur, Quake
Explorer, fournit ces fonctionnalités en combinant en une seule application plusieurs logiciels Java, dont Seis-
Gram2K (en version professionnelle seulement). Quake Explorer permet de consulter les bases de données sis-
miques du réseau sismique européen ORFEUS (Observatories and Research Facilities for European Seismolo-
gy), de sélectionner un séisme et une ou plusieurs stations des réseaux sismiques accessibles, puis :

• d'afficher une localisation de l'événement sismique souhaité sur un globe terrestre interactif (via un sous-
programme Seismicity Viewer) ;

• de visualiser et d'analyser les tracés (via SeisGram2K), soit en ligne, soit après téléchargement des données
sur le disque dur.

Figure 15. Utilisation du logiciel Quake Explorer : la fenêtre en bas de l'image est
l'interface de recherche et de sélection des séismes et des stations sismique. Les
enregistrements sélectionnés s'affichent dans le sous-programme SeisGram2K (fenêtre
de droite) tandis que les séismes choisis peuvent être visualisés sur une mappemonde à
l'aide d'un autre sous-programme, SeisViewer (à gauche).
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Dans ce qui suit, seule l'application SeisGram2K, utilisée indépendamment de Quake Explorer, sera présentée
en détail, pour souligner ses particularités par rapport aux autres solutions décrites ci-dessus.

SeisGram2K, version "Ecole"

Une fois les données sismiques récupérées (au format SAC, par exemple), le programme les présentent dans sa
fenêtre principale en différenciant les composantes par leur couleur (magenta : composante E-O ; jaune : N-S ;
cyan : verticale).

Figure 16. Visualisation dans SeisGram2K (version Ecole) des trois composantes
(verticale, N-S et E-O) du sismogramme d'un téléséisme (îles Kouriles, 13 janvier 2007)
enregistrée par la station du collège international de Valbonne du réseau « Sismo des
écoles ». Noter que les échelles verticales sont graduées en "counts".
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SeisGram2K permet, par les boutons situés dans la barre d'outil supérieure (de gauche à droite, cf; figure ci-
dessus) :

• d'augmenter ou de diminuer les échelles verticale et horizontale des enregistrements ;

• d'en sélectionner une portion ;

• de les faire défiler ;

• de revenir à l'affichage initial ou précédent ;

• de superposer les tracés

• de les synchroniser

Le bouton « Filtrer » permet d'appliquer un filtre au signal dans une gamme de fréquences choisie, tandis que le
bouton « Pointer » permet, comme dans GEE, d'ajouter manuellement aux tracés des repères indiquant les temps
d'arrivées des ondes (avec trois possibilités dans cette version Ecole : P, S et « Autres », c'est-à-dire les ondes de
surface). Le logiciel calcule automatiquement les différences de temps d'arrivée entre les ondes ainsi repérées,
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qui s'affichent dans la fenêtre inférieure.

Les deux derniers boutons de la barre d'outils supérieure, en haut à droite, permettent alors d'ouvrir un tracé
simplifié des hodochrones des ondes P et S, soit pour le cas d'un séisme proche, soit pour un téléséisme, et d'y
retrouver graphiquement la distance séparant la station du séisme (figure ci-après).

Figure 17. Exemple de pointé des ondes P (trait vert) et S (trait rouge) dans
SeisGram2K (Ecole) pour un séisme lointain enregistré par une station du réseau «
Sismo des écoles » et détermination graphique de la distance épicentrale (84 degrés) à
l'aide de la différence de temps d'arrivée P-S calculée par le logiciel et du module
intégré Hodochrone.

SeisGram2K, version professionnelle

Dans sa version professionnelle, le logiciel ne comprend pas les modules « Hodochrones » de détermination
graphique des distances épicentrales à partir des différences de temps d'arrivée des ondes P et S. En contrepartie,
il fournit plusieurs autres fonctionnalités d'analyse, entre autres : On peut aussi, avec cette version,

• la possibilité de pointer tous les types d'onde ou, d'afficher, comme dans GEE, les temps d'arrivée des ondes
calculées à partir d'un modèle ;

• la possibilité d'intégrer et de dériver les signaux sismiques par rapport au temps (ce qui permet, par exemple,
de revenir au mouvement du sol à partir du sismogramme initial représentant la vitesse du sol) ;

• divers filtrages des signaux.
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• l'association en 3D de l'enregistrement des trois composantes d'un sismogramme sous la forme du mouve-
ment d'une particule (une option disponible également dans GEE).

Cette version du logiciel, beaucoup plus puissante, devient par conséquent aussi plus difficile d'accès pour les
utilisateurs occasionnels peu familiers de l'analyse des signaux.

Quake Explorer et SeisGram2K permettent donc d'effectuer le même genre d'analyse que le logiciel GEE.
Quake Explorer et GEE sont presque équivalents, mais GEE est plus simple d'utilisation et d'avantage orienté
vers l'enseignement. Quake Explorer reste avant tout un outil de travail professionnel pour sismologues, tout
comme la version complète, professionnelle, de SeisGram2K.

Utilisée seule, SeisGram2K représente plus un complément qu'un équivalent à GEE, ce dernier offrant à la fois
plus de possibilités que la version Ecole de SeisGram2K, et moins que la version professionnelle.

Conclusion
Les sites et les logiciels d'étude et d'analyse de la sismicité sont donc aujourd'hui nombreux. Leurs utilisations
sont variées, depuis la simple illustration (répartition des séismes, aspect d'un sismogramme, etc.) jusqu'à
l'analyse poussée des signaux sismiques. Cet article n'en a décrit que quelques-uns, parmi les plus complets et
les plus faciles d'emploi pour les enseignants et leurs élèves mais aussi pour les étudiants de premier et second
cycle universitaire. Toutes leurs possibilités n'ont évidemment pas été décrites ici et si beaucoup proposent les
mêmes fonctions fondamentales, leurs fonctionnalités s'avèrent, dans le détail, souvent complémentaires.

Ces outils sont d'autant plus intéressants que plusieurs d'entre eux sont clairement développés dans cette optique
d'utilisation pédagogique en classe. Mais au delà de cet usage en milieu scolaire, ces instruments ont aussi pour
objectif la prévention du risque sismique et la diffusion dans le grand public des connaissances scientifiques rel-
atives à la sismicité.
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